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About this document
1 About this document
This document gives instructions on the maintenance of Nokia InSite Base
Station (BTS and power supply unit). Read carefully Nokia InSite BTS Warnings
and Cautions in this User Manual before starting the maintenance work. In the
case of an alarm, see Alarm Descriptions.

This document covers the following:

• periodical maintenance measures

• replacing the power supply unit battery

• replacing the power supply unit fuse

• LED indications

• Using Nokia BTS Manager

See Software release documentation for SW updating instructions.
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General
Note

2 General
This chapter describes the general issues that must be considered when doing
maintenance work on Nokia InSite Base Station.

2.1 Fault reporting

Report all damages, failures and faults to Nokia using the Failure Report Form
provided by Nokia Customer Service Center (CSC).

You can save the alarm information with the Nokia BTS Manager to a log file on
your PC.

2.2 Site folder

A site folder contains site-specific information required on the site. The site
folders include installation, commissioning and integration check lists. The exact
contents of the site folders are defined by the customer project.

It is the responsibility of the customer to maintain and archive site-specific
documents.
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2.3 Maintenance procedure

General maintenance procedure is the following:

1. When arriving at a site, check that all cables are properly connected and
that they are not damaged. Check that the power supply unit fuse has not
burnt.

2. Check the tools needed for the type of maintenance. See the tools list given
in Installation. You should always have the Nokia BTS Manager PC and
PC-cable with you.

3. Keep the BTS and power supply unit in their delivery packages until
installation.

4. After installation, keep some of the packing material for sending a faulty
BTS or power supply unit to service. Recycle the remaining material.

5. Perform the maintenance actions as specified in this document.
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3 Periodic maintenance
This chapter describes the periodic maintenance of Nokia InSite Base Station.

3.1 Periodic maintenance of BTS and power supply
unit

This section describes the periodic maintenance measures of the BTS and power
supply unit.

3.1.1 Air circulation

To maintain proper circulation of air, the air inlets and outlets of the BTS and
power supply unit must not be obstructed.

Do not cover the BTS or power supply unit.

3.1.2 Cleaning

The BTS and power supply unit covers must be cleaned of dust, whenever
necessary. Use a slightly damp cloth and mild detergent.

Do not wipe the BTS or power supply unit with a wet cloth.

In dusty conditions, the cooling fins under the antenna cover may need brushing.
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3.1.3 Cabling

When arriving at a site for maintenance purposes, it is always good to check that
the power and transmission cables are properly connected and that they are not
damaged.

If you need to check the quality of Abis connection, you can do it by choosing
‘Measurements’ on the Transmission menu of the Nokia BTS Manager.

The following values are recommended for HDSL:

Line attenuation: 0-30 dB

Noise Margin: 16-3 dB

The following values are recommended for E1:

Line attenuation: 0-6 dB

If the values are out of limits, you should check the cable type, the length of the
cable, the connections and the equipment at the other end. The maximum lenght
of cable for HDSL is 2 km (1.24 miles) and for E1 100 m (110 yd).

3.1.4 Measurement environment

External measurement equipment can be used for measuring e.g. the phase error/
frequency error, sensitivity or the power level of the BTS. This section describes
the generic measurement environment and procedure.

For measuring the phase error/frequency error, sensitivity or the
power level of the BTS, do the following:

1. Disconnect the antenna and the antenna connector. (For instructions, see
Requirements for Installation and Operation).

2. Connect the external measurement device to the antenna connector in the
BTS.

3. Connect the BTS’s 13 MHz connector to the external reference input in the
external measurement device.
12 (28) © Nokia Networks Oy DN99256359
Nokia Proprietary and Confidential Issue 2-1 en Draft
Confidential



Periodic maintenance
Note

Note

4. Connect Nokia BTS Manager PC to the BTS’s LMP port.

This test can be done only with a commissioned BTS.

5. Start the Nokia BTS Manager, choose the ‘Test’ menu on the menu bar and
select the ‘Send BCCH carrier’ command.

If you receive the error message ‘No TRX in configuring state’, choose the ‘Use
current’ command on the ‘BTS SW’ menu. With this command, the BTS will
become operational without Abis connection.
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4 Maintaining the power supply unit
This chapter describes the maintenance of the power supply unit.

Potentially lethal voltages!

Disconnect the AC plug from the socket outlet before starting the
maintenance work whenever the nature of maintenance work causes a risk
of electric shocks!

Disconnecting the AC plug is not necessary when replacing the battery of the
power supply unit.

Opening the back cover of the power supply unit is strictly forbidden!

4.1 Replacing the battery of the power supply unit

This chapter describes how to replace the battery of the power supply unit.

The battery of the power supply unit can withstand 600 cycles (recharge rounds).
However, it is recommended that the battery be changed within 3 years. The
battery can also be changed if the battery back-up time during a power outage
seems too short.

The lifetime of the battery depends on the ambient temperature and the quality of
the electrical network.
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Caution

Use only the NiMH 6HR-SCC 7.2V battery which is provided by Nokia.

Remove the old battery from the power supply unit as follows:

1. Open the power supply unit cover as shown in 1 of Figure 1.

2. Disconnect the battery cord. See 2 of Figure 1.

3. Loosen the DC cable which is guided around the guiding pins. You do not
have to disconnect the DC connector. See 3 of Figure 1.

4. Open the screw which is holding the battery support bridge in place.
Remove the battery support bridge and the old battery. See 4 of Figure 1.
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Figure 1. Removing the old battery from the power supply unit

Install the new battery into the power supply unit as follows:

1. Take the new battery and place it in the battery bay. See 1 of Figure 2. The
battery label should remain visible in the lower part of the battery bay. The
battery connection cord should be in its slot in the upper right corner of the
battery bay.

Press the locking clip
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Disconnect the battery cord
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Note

2. Connect the battery connection cord to the 3-pin connector, and install the
battery support bridge as shown in 2 of Figure 2.

DC cabling depends on the installation location of the power supply unit. Two
different ways are illustrated in 3 of Figure 2.

3. Guide the DC cable around the guiding pins, if needed. Push the strain
relief of the cable to the slot beside the connector. Connect the DC cable to
the 2-pin connector. See 3 of Figure 2.

4. There are two exit holes for the cables in the power supply unit. Arrange
the cables so that they come out through the exit holes.

Install the power supply unit cover. First, press down the upper edge, then
the lower edge, until the locking clip locks the cover on. See 4 of Figure 2.

5. Dispose of the old battery properly.

The battery is a NiMH rechargeable battery, and it must be recycled or disposed
of properly. Do not dispose of the battery in fire!

If the power supply unit is not working after replacing the battery, check the
battery fuse and replace it, if necessary. Check also the condition of the cables. If
the power supply unit is still not working, replace the whole power supply unit.
For installation instructions, see Installation.
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Figure 2. Installing the new battery into the power supply unit
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WARNING

4.2 Replacing the battery fuse

This chapter describes how to replace the battery fuse.

Potentially lethal voltages!

Disconnect the AC plug from the socket outlet before starting the
maintenance work whenever the nature of maintenance work causes a risk
of electric shocks!

The fuse may burn if there is a short circuit in the BTS or in the DC cable. If the
fuse has burnt, the power supply unit will still supply power from the AC/DC
converter to the BTS.

Remove the object which is causing the short circuit in the output, and replace the
fuse.

Figure 3 shows the location of the fuse. The fuse is located beside the battery
connector.

Figure 3. Location of the battery fuse

Battery fuse
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Replace the battery fuse as follows:

1. Disconnect the power supply unit from the mains outlet.

2. Open the power supply unit cover.

3. Disconnect the battery cord and the DC cable from their power supply unit
connectors. Check the battery connector and the DC connector for short
circuit.

In the case of short circuit, replace the battery or the DC cable. DC cable is
available as a spare part from Nokia. If there is no short circuit, reconnect
the battery cord and the DC cable.

4. Replace the battery fuse. Use only the subminiature fuse, the type of which
is TR5 (T6.3 A/250 VAC). The fuse is available as a spare part from Nokia.

5. Install the power supply unit cover.

6. Connect the power supply unit to the mains outlet.

If the power supply unit is not working after replacing the fuse, replace the power
supply unit. Check also the charge level of the battery and change the battery, if
necessary.
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5 LED indications
In addition to the alarms which a network element can produce, most functional
entities also have LED indicators. These indicators display the current state of the
equipment as a quick on-site reference.

5.1 LED indications

The LED indications are specified in Table 1.

You can disable the LEDs by choosing ‘Disable LEDs’ on the Objects menu of
the Nokia BTS Manager.

Table 1. LED indications

Location Colour Description Lit Flashing

Centre Green Power Power supply on BTS DC supply voltage level: AC
is off and the battery voltage is
too low or the battery is being
charged

Left Green Call On At least one call on Dummy BCCH transmission on

Centre Red Device Error BTS initialisation in
progress (LED is
switched off when
CONF_COMPLETE
message is sent to
BSC)

BTS internal error

Right Red Transmission
Error

- Abis link initialisation or Abis
disconnected (LED is switched
off when TRXSIG LAPD link is
properly established)
DN99256359 © Nokia Networks Oy 23 (28)
Issue 2-1 en Draft Nokia Proprietary and Confidential

Confidential



Nokia InSite Base Station Maintenance, DRAFT
24 (28) © Nokia Networks Oy DN99256359
Nokia Proprietary and Confidential Issue 2-1 en Draft
Confidential



Using Nokia BTS Manager
6 Using Nokia BTS Manager
This chapter gives instructions on how to get started with Nokia BTS Manager.
Nokia BTS Manager is used for local management of the BTS. It is assumed here
that the user knows how to use Windows 95/98 or NT4.0 software.

6.1 Starting and exiting Nokia BTS Manager session

The installation program of the manager SW creates a Nokia BTS Manager icon
on the desktop and defines its parameters. For more information on the
installation, refer to the Nokia BTS Manager online Help or the instructions on
the Nokia BTS Manager CD-ROM sleeve.

Start the BTS Manager as follows:

1. Double-click the BTS Manager icon on the desktop.

2. Enter the BTS Manager password if BTS Manager password checking is
on (only in Windows 95/98 environment).

3. Enter the BTS password if BTS password checking is on. The software
continues execution only if the BTS accepts the entered password.

The Nokia BTS Manager starts with the Supervision, Alarms and BTS
Events windows opened. Also, the software checks the BTS configuration
and displays it in the Supervision window.

If there is no connection to the BTS, only the BTS Events window is
displayed. Check the communications parameters. In this case, check also
that the LMP cable is connected to the same COM port that is defined in
the BTS Manager.
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Note

You can define different Manager options and communications parameters when
starting to work with the Nokia BTS Manager.

The Nokia BTS Manager must be connected to the BTS in order to make the BTS
password checking possible. If no connection exists, password checking is not
applicable.

To exit the Nokia BTS Manager, choose the EXIT command on the File menu.

6.2 Using Help

The Nokia BTS Manager software has a convenient, context-sensitive online
Help facility for getting information about a task you are going to perform, a
feature you might want to know more about, or a command you may want to use.

To get Help

• press F1

• click the Help button on the toolbar

• choose Nokia BTS Manager command on the Help menu or

• click the Help button in any dialog box.

In the Help Topics window you can see three tabbed pages: Contents, Index and
Find.

Contents

The Contents page displays a list of topics organized in books by category.

Index

The Index page lists keywords in alphabetical order through which different
topics can be reached.

Find

The Find page provides a full-text search functionality that allows you to search
for any word or phrase in the Help file.
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To exit Help, press ESC or ALT+F4.

If the BTS is connected, also the Help Topics for Transmission Unit Manager is
available in the Help menu.
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